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Dear Reader

This chapter of my book ‘The Complete Guide to Music Technology’ has been re-
leased to help people spend their time productively during the 2020 COVID-19 health 
emergency.

It’s designed to help anyone who is doing the right thing and staying at home to get 
started using Cubase, by using the included synthesizers to start making music.  A 30-
day trial of Cubase Elements is available, and this chapter has been tailored to suit 
that version.

I hope you find this useful, and you can feel free to distribute it wherever you want. 
The content remains copyright of Darren Jones.

If you do want to support the creator of this chapter, then please consider buying the 
complete book from Amazon.

https://tinyurl.com/cubasebookamazon

I appreciate there is a delay in delivery at the moment due to the current situation, 
but it is a time when freelance creators like myself have seen their incomes vanish, 
so your support is even more valuable than ever.

I hope you find this chapter useful, and it starts you on a lifelong journey of creativity.

Many thanks

Darren Jones

www.musictechtuition.com
www.youtube.com/c/musictechtuition
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Lockdown Learning:
Sequencing
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Cubase Elements 10.5 is music producti on soft ware - oft en called a Digital Audio Workstati on (DAW) 
- and one of its features is that it is a sequencer.  This means it can record notes that you play on a 
keyboard, and then play them back through a synthesizer, allowing you to create compositi ons and 
hear what they sound like without using other musicians.  Very complex pieces of music can be built 
up doing this as you can create one track at a ti me and re-record it unti l you are totally happy with 
it, all at your own pace.  You don’t need to be a good keyboard player to get good results, either (al-
though having some keyboard skills is a big help).  It’s important to remember that it deals with MIDI 
(which will be covered fully later on), and that really means notes being played, usually on a keyboard, 
so you can change the sound of what you’ve recorded aft erwards, but there are some limitati ons to 
how it will sound.

Ge�  ng Started
Firstly you will need to start your computer and any other items in your setup.  The order of this will 
change depending on your specifi c equipment, but there is a good rule of thumb here:
Tip: The speakers should be the last thing you turn on, and the fi rst thing that you turn off  – this is 
to avoid any ‘thumps’ damaging them (or your ears) when you turn the equipment on.  Usually the 
computer will be one of the fi rst things to be turned on and the last to turn off . Once this is done, you 
can start Cubase. 

 Once it loads (which can take some ti me as it’s a large program), you will 
see a screen like the one on the left , it is the Steinberg Hub and it is there 
to allow you to pick from a number of templates, as well as tell Cubase 
where you want your project to be saved.

Tip: Whenever you use Cubase, it’s important to make sure your fi les are where they should be – in 
some situati ons the computer is used by a number of people, and in additi on it’s really important to 
save each project in a separate folder – this means you will easily be able to back your work up later 
on.
To create a new folder for your project, click in the area next to Project Folder at the bott om right of 
the Steinberg Hub window, and type the name of the folder you want to create, and then in the upper 
secti on click More and then pick Empty.  Now click the Create butt on at the bott om and Cubase will 
make the folder and a new project. 
Tip: Remember that USB fl ash drives and external hard drives are becoming increasingly aff ordable, 
and their cost is small compared to the amount of ti me that you would need to recreate any work if 
it was lost.  Backing up your work is a necessity, as is regularly saving your work.  Computers crash, 
parti cularly when running complex soft ware such as sequencers, and hard drives fail.  If you save 
regularly and back up oft en then you will not lose a great deal if the worst happens.

Here we see the main Cubase window, with the Transport Bar 
at the bott om.  The transport bar is like the remote control 
for a video recorder, although it has more functi ons, the basic 
controls are the same, as we’ll see later on. The central area is 
the project window.  This is where all your tracks will be cre-
ated and the majority of your work will be.
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The fi rst thing to do is to create a new track.  Go to Project > Add Track > Instrument, and a new 
window will appear where you can select an Instrument.

Click where the window says No VST Instrument and a list will appear of the instruments your com-
puter has available.  Pick Prologue from the Synth folder (as it is available on all Cubase 10.5 systems), 
and click Add Track.  You should now see a screen similar to the one shown below.

Here is the Cubase window, with Prologue located in the cen-
tre of the screen.  While you will be editi ng the controls later 
on, at the moment we don’t need to see Prologue, so close 
the window to reveal...

... the project window with Prologue track in it.  On the left  
of the screen is the Inspector, showing details such as track 
name, inputs and setti  ngs.  If the inspector isn’t present...

... click this butt on to make it visible.  It can also be enabled 
with CTRL + ALT + L.

The Inspector is very important as it allows you to alter the volume and panning of a track (more of 
this later), and most importantly pick the sounds you wish to use.  We will see how this works in a 
while, but fi rstly we will look at a few things we need before we get started.
  The  Transport
The transport (hit F2 if you can’t see it) allows us to control Cubase, making it play, stop, record, re-
wind and a host of other features.  We won’t cover them all here, but we will cover the basic controls 
that you need to get you sequencing.

The transport controls. The highlighted butt on is STOP, and to the right are 
PLAY and RECORD.  The butt on on the left  turns CYCLE on and off , allowing 
us to repeat a parti cular secti on - see page 12.

Tempo control, metronome and count-in.  Here the tempo can be set 
(once the tempo track is turned off  by clicking the butt on at the left ), and 
the click can be turned on and off  with the butt on to the left  of the e.
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Time readout.  This can be in a number of formats, but bars and beats (at 
left ) is probably the best setti  ng.

Locators.  As we’ll see later on, the locators allow us to cycle round a sec-
ti on, to practi ce it or record several ti mes.  They can be set by double-
clicking the numbers and typing a new value.
Input/Output acti vity.  This shows MIDI in and out (left  two meters) and 
audio input and outputs (stereo).

The Transport Bar in Cubase 10.5 is highly confi gurable - and would take several pages to describe 
all the available opti ons - but suffi  ce to say that you can turn secti ons on and off  using the cog at the 
right hand side, and alter the appearance of each secti on by clicking the three dot menu to the right 
of each secti on.

Here we see the eff ect of this on the transport controls secti on.  The 
fi rst view is the default with just four controls present.  The next 
mode adds butt ons to move between markers, and the third mode 
adds fast forward and rewind controls.

The  Metronome
It is very important that when you play music into Cubase that it is in ti me with the metronome.  
Computers may work extremely quickly, but they do not have much intelligence, and as a result they 
need to be told things that we may take for granted.  One of them is the tempo of a piece of music 
– Cubase can’t really work that out, so to make life easy in the long run, you should play in ti me with 
the metronome.  This is easily achieved, fi rstly by turning it on using the butt on above - it will turn 
white. Pressing Play on the transport bar should now mean you hear an indicati on of the tempo of 
the piece. 

Changing  Tempo
If you want to change the speed, make sure that the tempo track is turned off  click the butt on above 
on the transport bar so that it is dark grey, and then enter the tempo that you want by double-clicking 
it and typing the speed you want.  You may need to experiment to fi nd the right speed, and remem-
ber that you can always change the speed of what you’ve recorded aft er you’ve done it.  This has an 
important benefi t if you’re fi nding a part diffi  cult - you can record diffi  cult parts slowly to make them 
easier to play, then return the tempo to normal aft erwards.
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The on-screen Keyboard
If you don’t have a MIDI (music) keyboard att ached to your computer, it’s easy to think that you won’t 
be able to play music - that you’ll just have edit it to create it.  This isn’t true, however, as Cubase 
comes with an On-Screen Keyboard.  This can be acti vated using ALT + K and you will see a window 
like the one below:
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The lett ers on the keyboard equate to one octave of musical keyboard - Q will play a C, W a D, and 3 
a D#, etc.  Don’t worry if you don’t know the notes, just have a play and listen to the sounds you are 
generati ng.  While it is not as easy as using a hardware music keyboard, if you don’t have one, it’s a 
good substi tute.  The 7 grey boxes under the notes (one will be lighter grey than the others) shows 
which octave you are in, which can be changed using the cursor keys (← and →):

The slider on the right-hand side controls the velocity - this is how ‘hard’ the keys were hit, and some 
synths will change sound depending on this, so you may want to experiment with the slider as you 
press keys to see what sound works best.

It’s possible to use the on-screen keyboard in a multi -octave mode by clicking the circle at the bott om 
right.  This changes the appearance as shown ...do
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... and allows playing of a few more notes (up to an E, pressing the P key), allowing a bit more musical 
fl exibility.  It’s also possible to use the mouse to create pitch bend (smooth changes between notes) 
and modulati on (vibrato, a rapid change in pitch) by clicking and dragging up / down or left  / right on 
a note.  This can be a litt le tricky, but with practi ce can allow you to create these techniques more 
quickly than manual editi ng.
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 Picking a sound
Many synthesizers provide a wide range of sounds (referred to as patches) and these should cover 
most eventualiti es – there are usually over a hundred on a basic synth, and on some there can be 
thousands.  However, picking them can be a litt le diffi  cult as there are so many to choose from, but 
the Inspector makes it easier.

Here is the inspector, with the Prologue in the track.  The black area at 
the bott om (above No Drum Map) is where the patch name will appear 
when one is selected, so click there... 

... and the patch list appears.  Here you can list all the sounds that the 
synth has, and there are many (334, as shown at the top right).  If you 
want to explore, feel free to do so, you can scroll through the list and 
click once on a sound and you will be able to hear it played using your 
MIDI keyboard – you may fi nd a sound that inspires you or takes your 
compositi ons in new directi ons. 
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There are so many sounds that it’s hard to fi nd the right one quickly.  
If you click where it says Search Results and enter a word (or part of 
one) then it will only show you sounds that are relevant to that – both 
in their names and also their categories/descripti on, so if you enter 
bass (as seen here) then you should get bass sounds, even if their 
name doesn’t make that obvious.  Not all instruments have descrip-
ti ons in their patches, however.

Naming Tracks and Parts
It’s important to name each track – at fi rst it’s easy to know what’s what as you may only have one 
or two tracks.  When your piece develops, you may end up with many tracks, and knowing instantly 
what each one is will help.  To name it, double click where the track says Prologue 01 and name it 
appropriately – melody, bass, chords or whatever you want to call it. 

The Info Line
If you have the Info Line present (if it isn’t, click the icon above right and select it from the menu that 
appears), then you can name the parts you create as well, avoiding confusion if you have musically 
diff erent parts.  It can also be of benefi t to use the colour palett e  to colour parts, providing an instant 
visual clue when a part is diff erent from its neighbours.
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Toolbar and Transport Setup
There is a great deal of information that can be present on screen in Cubase, and both the toolbar 
and transport bar area have too many options to fit on most screens.  As a result, you will need to be 
familiar with getting the tools you need on screen.  This is done using the cog icon which allows the 
setup of the toolbar or transport to be altered.  If a tool, icon or menu is mentioned in this book and 
you can’t see it, then click the cog and turn that section on.  You may need to turn other sections off 
to see the desired section in full - particularly in the case of the transport bar (where some sections 
can be expanded in size, as seen on page 5).

Making a recording
Cubase will record whatever you play on the keyboard.  To do this, select a track (if you only have one 
it will already be selected, this is shown by it being lighter than the others), and look to see that the 
red ‘record enable’ button is lit up on the track itself – it should be as soon as you select the track, but 
it’s possible for it to be turned off.  This button doesn’t mean that the track is recording straight away, 
but it means that when you press record it will record on this track.  Next, we need to tell Cubase to 
give us a count-in (normally this is 2 bars).  This is done by activating the Count-in button, near the 
metronome button– it looks like this: 

If you can’t see the count-in button, press the three dots to the right until you can see it. Now make 
sure Cubase is at the start of the song, and hit Record.  Cubase will give you a 2 bar count-in, and then 
start recording.  Play something on the keyboard, and you should see it appear as you’re recording.  
Once you’re happy, press Stop.  Go back to the beginning of the piece (pressing , on the keyboard next 
to M will do this, although a good way to remember it is to think of the < pointing back to the start of 
the project) and press play to hear what you recorded.
If you’re not happy with the recording, then often the best thing to do is to delete it and start again – 
unless there is some unique part of it that you think you could never reproduce, the best thing to do is 
to start again, as this will improve your keyboard skills quite quickly if they need to be improved, and 
mean that in the future you can sequence things with much more speed and accuracy.  
Tip: To delete a part, select it (left-click it) and then hit Backspace on the computer keyboard.  
To record again, just repeat the steps above.
Snap
Snap is extremely important.  Without it, it would be very difficult to make parts in the project win-
dow which were exactly the right length, whether it’s bars or beats we are after. What snap does is 
makes sure that any movements you make and any edits you do are constrained to a grid, which mini-
mizes the room for errors. Whenever you’re making any changes in the project window, make sure 
that snap is turned on, and initially make sure that it’s set to Bar.  The settings for Snap are found at 
the top of the project window, and the correct ones are shown below:

The button at the left turns snap on or off.  Next to it is an area that shows the current setting (which 
is set to Grid).  The size of the grid is set by the next two boxes - the first is currently set to Bar (which 
we want).  Ignore the 1/16 section for the time being – this only applies if the middle menu is set to 
Use Quantize, which you will need later on.
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Later on, as your sequencing develops, you will find times when you don’t want to use snap, or you 
want it set to different values.  But initially it’s best to stick with it set to a grid of bars, as this leaves 
the least room for problems!
Trimming a part to size
When creating a song, it’s often made up of smaller ‘building blocks’ – these could be a verse, chorus 
or other section of a song that you wish to repeat.  When you originally record them, they might end 
up being too long, for instance if you didn’t hit stop right on the end of a bar, you may well end up 
with a bar of silence.  This can be easily trimmed away – just hover your mouse over the part in ques-
tion, and it will have small  ‘handles’ at the bottom corners – one for the start and one for the end.

Here we see the part, with a bar of silence at the end.  
At the bottom corners there are ‘handles’ which you can 
click and drag to size the part.

If the part has been selected, it will look like this - dark 
with the ‘handles’ being lighter.

In either case, you can click and drag the end one to the 
left...

... to produce a part of the correct length.  Note that if 
you do this to an area which has notes in it, they will not 
be played, but they are not lost – you can extend the part 
again using this technique and they will re-appear.

Make sure snap is turned on when doing this, or the timing of your part will suffer.
Adding another track
To add another track, you can do so in the way you did before – go to Project > Add Track > In-
strument.  It is important to experiment with the different Instruments you have on your system, 
which can create a wide range of sounds.
Adding Drums
Drums are an important part of many styles of music, so adding them is often needed.  To do this, 
create an instrument track as shown above, but this time you will pick Groove Agent SE from the 
Instrument menu.  Now, using the patch selector (as shown on page 8) pick the Dry Standard Kit 
(remember you can search for it with the keyword ‘drum’). This means that instead of playing notes, 
the keyboard will play drum sounds – on most keyboards/synths you will find that the C note to the 
left of the keyboard will be a bass drum, with snare above it on D and E, toms above that, while the 
hi-hats will be on F#, G# and A#.  Learning what sounds are where will take some time (experiment to 
find which sounds are where), but the basic parts of the drum kit are found on the left-hand end of 
the keyboard.   As before, recording drums is just like recording any other MIDI, although the playing 
may be more complex if you’re trying to play a full kit’s worth at once.
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Adding more notes to a part
If you have problems playing all of a drum track at once, then there are a number of ways to do it.  The 
first way is to record ‘on top’ of the first part you have recorded.  Simply go back to the beginning of 
the track, and then record again on the same track – the notes you’ve already played will be played 
back to you, and you’ll create a new part on top of the original one; Cubase will show the part with di-
agonal lines on it to show you that there is more than one part in that location, and once you’re happy 
with the second part you have made, you can select the ‘glue’ from the toolbar at the top and glue the 
top part to the bottom – you’ll now see a part with both sets of notes in (see diagrams below).  Once 
you’re finished working with the glue, you can return to the arrow tool, either by using the toolbar, or 
right-clicking on the white area of the project window and selecting it from the pop-up menu.

Here we see the initial part that has been recorded.  Cubase is set to 
record from the start on the same track, and we see below.....

... that the notes get recorded and seem to be in the same part, but 
the part has a diagonal pattern on it - this shows that there is another 
part below this one.  Both still play, even though they are on top of 
each other.  If we want them to be one part, we select the glue from 
the toolbar above, and click on the part, leading to...

.... a final part which has the notes of both parts.

Picking which tracks play
Cubase has two important buttons which will let you hear the tracks you want, and stop others from 
playing.

Mute
Mute will stop any track that has it turned on from playing.  Click on the button so that it is selected 
in yellow, and play your track back - the track will not be heard.  You can do this for as many tracks as 
you want.  To un-mute them, either click the mute button on the track, or you can clear all mutes with 
the clear mutes button which is in the toolbar at the top of the window.  

If you want to mute a track you have selected (i.e. it is in white in the list) then press M on the key-
board.

Solo
Solo will mute all tracks other than the one(s) you have soloed (press S).  This makes it quick and easy 
to hear a track you want to hear in isolation.  You can solo multiple tracks if you want, and each one is 
toggled by clicking the solo button on the track in question. CTRL clicking a Solo button will mute any 
other already soloed tracks.  As with mute, there is a clear all solo button in the toolbar at the top of 
the window.
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Creating an arrangement
Usually, a song will consist of several parts, some of which will be repeated.  This can be done quickly 
and simply in Cubase.  Firstly, create the parts that you want to use for the song – you can do this 
on several tracks, using different instruments, but for clarity the diagrams below will only show one 
track.
The first thing to realise is that you can move any part to a new location by clicking and dragging it 
there.  When you do so, make sure you have snap turned on, as then your part will be in time.  You 
can also drag a part to a new track to make it play on a different sound – sometimes this happens 
accidentally.  
However, often copies of the original parts are needed, to make the piece larger – repeating sections 
of an entire song, or copying a bar from one place to another.  There are a few ways to do this, as 
seen below.

Here we see the original part, 4 bars from bar 1 to 
bar 5.   For each step below, the first part has to be 
selected.

Edit > Functions > Duplicate.  A single copy is 
made, directly after the original part.

Edit > Functions > Repeat.  A new dialogue box 
appears, asking for the number of copies – here 3 was 
entered. Useful for creating many copies.	
Holding down ALT while dragging the part to a new 
location will create a copy – this is useful when a copy 
doesn’t need to be directly after the original.

Using these simple techniques allows a song’s structure to be built up quickly and easily.
Practicing a section
When a part is simple to play, then it can often be done with little practice.  But sometimes it’s nec-
essary to repeat a section so you can practice or work out what you want to play.  Here’s where the 
locators come in.  Cubase has two main locators, left and right.  They can be used to create a cycle 
which Cubase will repeat until you tell it otherwise.  To do this, firstly we need to set the left and right 
locators.  This can be done in a number of ways:
1 – Double-click the area on the transport bar where the current value of the locator is, and enter a 
new value.  For bar 5, just hit 5 and Enter on the keyboard.
2 – You can CTRL-click on the ruler (showing the bars across the top of the project window’s white 
area) to set the left locator, and ALT-click to set the right locator.  This needs accurate mouse place-
ment, though.
3 – If you have a part or parts that you want to cycle round, select them and then hit P on the key-
board.
All of these will set the locators, and once you have done this, you can activate Cycle on the trans-
port bar (the button to the left of stop – it will turn blue when it’s on), and Cubase will cycle round 
the contents between the two locators.  You can now practice the section that you wish to record or 
create until you get it right.
Cycle Recording
While cycling to play a section and practice it is useful, it is also useful sometimes to record while in 
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cycle mode.  This gives a number of different options, including recording several different versions of 
the same part, or to add notes to the part as you go.  We will look at three of the available options.
Adding notes to a part
A common need is to add notes to a part.  While we have seen this being used when recording with-
out Cycle mode, in cycle mode it is possible too.  The first thing is to ensure that the MIDI Record 
Mode is set to Mix, by clicking the button below:

Clicking here will summon the MIDI Record Modes menu:

Now, with the locators set, a part can be played.  Each time round the cycle, the notes you play will be 
added to the previous notes - they will not overwrite them.  This is a quick way of building up a drum 
part, as seen here.  The first time round the cycle, the bass and snare drums were played:

The next time round the hi-hats were added:

You can cycle round as many times as you like, and whenever you add a note it will become part of 
the recording.
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Keeping only the last version
If you want to keep only the last version you record, this is easily done.  Set the MIDI Record Mode to 
Keep Last:

Now proceed as in the previous section; when you stop, only the last version you did will be left.  This 
can be useful when you are trying to get a part right, and will stop as soon as you have done that.  
Often if you keep starting and stopping to record, it can stop you from getting in the feel of things, so 
having Cubase cycle round until you get it correct can save time. 
Recording different versions
Sometimes, you may want to keep recording while you play different versions of that section, and 
then decide later which version you want to keep.  To do this, set the MIDI Record Mode to Stacked, 
from the right-hand side of the pop-up menu on the Transport Bar.

As you record with cycle turned on, you will see each part recorded, and it may look as if the other 
versions have been lost (much as in the previous section) - here is the result after four cycles.  

Note that the part says Take 4 - this was on the fourth repeat.  If we play the track back, we get the 
fourth version that was played.  However, the others are still present.  Clicking the Show Lanes button 
will reveal the previous 3 Laps.
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At present, Lap 4 is the version that is heard.  If you want to hear another one, you can use the Mute 
tool to mute one of the lanes, and then again to allow another one to play (see page 25 for the 
Mute tool).    Note that if you change the lane which is active, the note display on the track changes to 
reflect the part that will be played - here Lap 2 has been chosen, and the track part reflects this both 
in name and note content.

If you want to return the track back to being viewed normally (without lanes), then click the Show 
Lanes button again.



16

Lockdown Learning - Cubase Elements

do
w

nl
oa

de
d 

fr
om

w
w

w
.m

us
ic

te
ch

tu
iti

on
.c

om

Retrospective Record
There will be many times when you will play an idea that you think worked well, but you weren’t 
recording it - and sometimes it can be difficult to remember exactly what you did.  In the past, this 
would have been gone forever, but Cubase has a feature called retrospective record which essentially 
means Cubase is always recording MIDI input.  This means all you need to do is press the retrospec-
tive record button and the events will be put onto the currently-selected track.

Here’s an example - while it is difficult to see something that hasn’t happened in a screen shot, you 
can try this yourself to get a chance to see how useful retrospective record can be.  The setup is sim-
ple - a single instrument track in a project.  Play was pressed (but NOT record!) and a MIDI keyboard 
was played for a few bars of melody.  After hitting stop, this was the result:

No MIDI data has been recorded to the track.  However, pressing the retrospective record button will 
make Cubase behave as if record had been pressed:

The MIDI data can now be edited as normal - it is now a normal MIDI part.  Retrospective record has 
another trick up its sleeve - you don’t even need to have pressed Play - if you have just been playing 
MIDI while Cubase has been in Stop mode, it will still record.  Again, starting from a blank track, but 
not pressing play, MIDI notes were played on a keyboard.  Pressing retrospective record this time 
once more generated a recording:

Clearly the timing of this may be off (as there was no metronome to play along with), but it can still be 
invaluable to capture those inspirational moments that come along every now and then.
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Editi ng
One of the most powerful reasons to use a computer for creati ng music is that you can alter what 
you’ve played aft er the event – you can change the sound that something is played back on, and you 
can also alter the notes that you’ve played.  Simple editi ng will save you hours of work – while it is 
always a good idea to try to improve your keyboard skills and play something in real ti me, there will 
always be ti mes when you will need to edit what you have played.  To open the editor, double-click a 
part you have recorded.  This will open the ‘key editor’, which is like the paper roll from a player piano.

Here we see the key editor, with ti me running 
from left  to right, and the notes going up the 
left -hand side of the screen, from low to high.  
The notes of the part are represented as rec-
tangles, and the colours show how hard the 
note was hit (called Velocity in MIDI terminol-
ogy), from blue to red (soft  to hard).

The fi rst editi ng is quite simple.  As we’ve seen in the project window, each note can be moved to a 
new locati on, and again it is controlled using snap – this will make the notes ‘sti ck’ to a grid, and we 
can set the size of the grid. 

Listen to the part you’ve created, and work out the grid that it should fi t to – if it has only one note 
per beat (quarter notes/crotchets), then set the snap to ¼.  If it has two even notes per beat (eighth 
notes/quavers) then set it to 1/8, etc.  Once you have done this, you can move the notes to the ‘cor-
rect’ locati on by clicking and dragging them – note that the positi on that you click on the note is 
crucial – if you click at the beginning or end you drag the note out.  If they are all fairly close and you 
have set the snap setti  ng correctly, then hit Q on the computer keyboard for ‘quanti ze’ – this will move 
each note to the nearest ‘correct’ grid positi on; this may or may not work well depending fi rstly on if 
you’ve chosen the correct snap setti  ng, and secondly if you’ve played it accurately!  It’s not unusual 
to have to correct some notes by hand, but quanti zing can save a lot of manual work.  If there are any 
notes that you don’t want, you can select them and hit Delete.   
You can also edit the velocity of the notes that you have played (i.e. how hard you played them – for 
most synths this translates into the volume of the notes being played). This is done in the “controller 
lane” at the bott om of the window, as seen here:do
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If there is no controller lane, click on the plus at the bott om of the editor area and one will appear.  

If the controller lane is not displaying velocity, click on the triangle that appears on the current con-
troller name to bring up the pop-up menu, and pick Velocity from it.
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ity is what we’re aft er at the moment. You should see coloured bars which represent the velociti es of 
each note that you have played – by default, they will be short and blue for lightly-played notes, tall 
and red for notes that were played loudly, and in-between for others.  You can see that in this exam-
ple, they are all the same velocity (100 in this case, from a range of 1-127).

To edit the velociti es, you can move the selecti on tool over the velocity area - note that it turns into 
a pencil when you move there.  You can now click and drag the note velociti es to the desired levels, 
and you should hear the eff ect of doing so.

You can also use the line tool in a variety of modes (see page 26), which will allow you to alter the 
velociti es in a number of diff erent ways.

Once you’re fi nished in the editor, hit Enter and you’ll be back to the project window.
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 Non-Keyboard player ti ps
If you are not already a competent keyboard player then you may fi nd sequencing quite frustrati ng or 
diffi  cult – parti cularly if you are trying to sequence something that already exists.  There are a number 
of things you can do to help your situati on:
Keyboard Skills – improving these will pay the largest dividends.  If you can learn basic keyboard 
technique it will enable you to translate your ideas into parts a lot more quickly.  Knowing where the 
notes are on the keyboard is important, as is being able to play simple chords.  If you can gain some 
independence between your two hands then this will make matt ers even bett er, parti cularly when 
you start to program drum parts in real ti me.
Slowing things down
Oft en a complex part will be diffi  cult to play at the correct speed, and one way round this is to slow 
Cubase down, and then play the part at a lower (achievable) speed – see page 6 – and you can 
then put Cubase back to the original speed.
Recording rhythm then changing the pitch
This is a useful skill when you know what you want to play but can’t do it quickly enough (or it’s too 
complex to get).  Firstly, pick a note that fi ts OK with whatever backing you have, and then record the 
correct rhythm of the piece, but all played at the same pitch – this should be doable for just about 
everyone.  Below we see the rhythm of our melody has been recorded, all on a single note.

do
w

nl
oa

de
d 

fr
om

w
w

w
.m

us
ic

te
ch

tu
iti

on
.c

om
The next step is to correct the pitches of the notes that you’ve played in.  You can do this by editi ng 
each one, but it can be laborious.  If you know what notes you need to play (which is oft en the case 
with a melody which you know or that’s writt en down) then open the part you have just recorded in 
the key editor.  Select the fi rst note of the melody, and then click the MIDI Input butt on at the top.   
This enables input from the MIDI keyboard.  You will see there are three butt ons with notes on to the 
right of this.  Make sure the ones with the arrows are turned off  - this will mean only the pitch of the 
note is being altered as you press keys on your keyboard.  The correct setti  ng is shown below.

You can now play the correct pitches in, one at a ti me, and Cubase will alter the pitch of the current 
note, and move to the next one.  In this way anyone who can’t read music quickly can input a rhyth-
mically accurate version and then change the pitches quickly - below is the part with half the notes 
replaced.



20

Lockdown Learning - Cubase Elements

do
w

nl
oa

de
d 

fr
om

w
w

w
.m

us
ic

te
ch

tu
iti

on
.c

om

Below is the completed melody.  Don’t forget to turn MIDI Input off after completing the task, as oth-
erwise you may accidentally alter a part without realising. 

Step Input
There is another way to record MIDI data in Cubase, and instead of being in real-time (like the record-
ings we have already seen), it is done in what is called ‘step time’.  This means that there is no clock or 
timing running, instead Cubase will move forward in time each time you play a note, and you can wait 
as long as you like between them.  This removes the need to play notes in quick succession, which can 
often be useful for those first using the keyboard, or when sequencing parts which are too difficult to 
play at a reasonable speed.  It also opens up some more creative possibilities as well.
To use Step Input, firstly create a new, empty part.  This can be done in a number of ways, either se-
lecting the pencil tool in the project window and clicking and dragging to draw the part:

Or if you have your locators set you can double-click between them on the appropriate track.  

Once you have your part, double-click it to open it in the editor.  You will now need to turn Step Input 
on, using the icon located towards the top of the editor. (you may need to enable Step/MIDI input 
by clicking the cog in the top right of the editor window)

Next, set the step size.  This is done by altering the quantize value at the top of the editor, seen here 
set to 1/8.

Finally, you will need to set the step input location - where you want the first note you play to appear.  
Usually it will be at the beginning of bar 1. You can change it by pressing the left and right cursor keys 
on your keyboard - you should see a blue line showing where it is (it becomes yellow when it coin-
cides with Cubase’s play position line).  You can also set it by clicking in the main section of the editor 
window (where the notes appear).



21

Lockdown Learning - Cubase Elements

do
w

nl
oa

de
d 

fr
om

w
w

w
.m

us
ic

te
ch

tu
iti

on
.c

om

Here is the empty part, with the step input line on the left  - it is in yel-
low as the play positi on line is there too, so diffi  cult to see.  However, 
Cubase is ready to take the next note or chord played, and when you 
do so and release it...

...two things happen:  Firstly, the note or chord that you played has 
been created in perfect ti me - it starts precisely where the input loca-
ti on was set, and it is exactly the length you set.  Secondly, the blue step 
input line will have moved on to the next grid division, ready...

... for the next one.  Once it is played and released, the same thing hap-
pens again - the ‘perfect’ chord/note is created with the right start and 
end points, and the step input line moves another division forward.  

Note that it’s possible to change the quanti ze value without leaving 
step mode - the next chord/note you play will be input with the value 
you have set (here it was changed from 1/8 to 1/4).

Note that when you are using Step Input, once you press a key on the MIDI keyboard, you can press 
more keys to make a chord, and it is only when you release them all that the input is actually taken, so 
you don’t have to hit all the notes at the same ti me.  As with MIDI note input above, ensure you turn 
Step Input off  when you have fi nished, or you can enter notes without realising it!

Saving your work
This is the most important thing you can do!  Make sure that you save your work regularly.  It is an 
unfortunate fact of life that computers crash someti mes.  Cubase is a very complex piece of soft ware 
– we’ve just scratched the surface of it here – and someti mes it crashes.  Whenever you’ve done 
something that you like, save your work! It’s quickly done by pressing CTRL+S, and it can save you 
hours of ti me if something goes wrong.  You can also set Cubase to auto-save by going to Edit > 
Preferences > General and ti cking  Auto Save – it’s really easy to forget to save work in the middle 
of a sequencing session, so this is a good idea.  If you need to back your work up, then see page 44 
for how to do this.
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The toolbar
At the top of the project window and editors in Cubase you will see the toolbar.

This allows you to select different tools, making the mouse cursor perform different tasks.  We will 
now look at the tools that are available to you, and some of their uses. 

The Selection Tool (Press 1)
This is the default mode - the arrow that you have already been using - where you can click and drag a 
part to a new location, and use the sizing handles that appear to alter the length of parts.  This is the 
mode you will use more than any other, and it can be accessed by pressing 1 on the main keyboard.  
If you click and hold on the tool on the toolbar, a pop-up menu appears:

This allows the selection of different modes for the tool, which alter what happens when you re-size 
an event.  Note that pressing 1 repeatedly will cycle through these modes.
Normal Sizing
As we have already seen, it is possible to click and drag a start or end handle, and change the length 
of a part.  This is the default mode.

Sizing moves contents
In this mode when you re-size a part, the contents will move when you do so.  Here is an example to 
show that in action.

Sizing applies Time Stretch
In this mode, when you re-size a part, the contents will be stretched or squeezed according to the 
change in length that you apply.  Here is an example to show that in action.
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The Range Selection Tool (Press 2)
The Range Selection Tool lets you click and drag to select an area across a number of tracks, and then 
move the contents of the area you have outlined to a new location by clicking and dragging.  It can 
be useful for making large changes to a sequence without having to spend a long time separating all 
the parts that you want by using the scissors (see the next section for the scissor tool).  Here we see 
a sequence which has had an area selected by clicking and dragging.

Once the area has been selected, hover the mouse over it - it will turn into a hand and now the area 
can be moved by clicking and dragging.

Combine Selection Tools (Press ALT + SHIFT + 1)
It is possible to use both the selection and range selection tool by clicking the button to the left of 
the selection tool.  In this mode, range selection works in the top half of a track, and selection in the 
bottom half.  It can save on mouse mileage, and make for a faster, more productive workflow once 
you have mastered its intricacies. 
However, it can be frustrating to use at first as you need to be accurate when working in the project 
window , and it may well be something that is best left turned off while you master the use of each 
tool individually.
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The  Scissors (Press 3)
The scissors allow you to cut existi ng parts into smaller ones.  Here we will see the scissors in acti on 
- here is an existi ng part:

Clicking with the scissors at bar 2 creates 2 parts from the original.

Note that the long note from the end of bar 1 (which extended over the bar 2 line where the cut was 
made) does not appear in the second part - the notes themselves are not cut.  Looking inside the fi rst 
part shows us that the note is intact, and extends beyond the new part.  
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This can lead to some confusion when cutti  ng parts with MIDI notes in, so be aware that things like 
this can happen.

The  Glue (Press 4)
The Glue tool allows parts to be glued together and become one part.  Taking the parts created by 
cutti  ng above, we can see that the reverse of the cutti  ng process happens:

Clicking on the fi rst part glues it to the following one, as seen on the next page:
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Note that the long note from the first part now has its true length shown. Glue can bridge the gaps 
between parts, as seen here:

Later on, when working with audio, note that glue will only glue audio events together that originally 
belonged together; if they didn’t then an audio part will be created, which is a container with multiple 
audio events in it.

The Eraser (Press 5)
The eraser allows you to delete parts by clicking on them.  It is often quicker to stay on the Selection 
tool, click on a part and hit Backspace on the keyboard, but you may prefer using the erase tool.

The Zoom Tool (Press 6)
As its name suggests, the zoom tool controls zooming in and out.  It has two main ways of working.  If 
you click on a track without dragging, it will zoom in.  ALT+click will zoom out.  However, if you want 
to zoom into a particular area, you can click and drag that area using the zoom tool, and once you 
release the mouse button, that area will fill the screen.

The Mute Tool (Press 7)     
The Mute Tool can be extremely useful - it allows the muting of a part, stopping it playing without 
moving or deleting it.  This can be extremely useful for creating arrangements and testing ideas out.  
Here we see an original track, with three parts:
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The middle part will now be muted using the mute tool - note that it has gone grey (easier seen on 
screen than in print!), and it will not be played.  

Clicking again will allow the part to play normally.

The Pencil Tool (Press 8)
The Pencil (or Draw) tool allows the creation of parts and events - this has already been seen on the 
section on Step Input on page 20.  Clicking and dragging with it will create new parts or events, 
controlled by your current snap settings.

The Play Tool (Press 9)
The Play Tool allows you to play a part by clicking and holding on it.  Note that only the part you click 
on will be played - if there are other tracks which happen at the same time they will not be played.  
This is similar to using Solo, as covered on page 11.

The Line Tool
The Line tool has a number of modes, as seen below.

Line - creates straight lines

Parabola - creates curves.  Pressing CTRL flips the curve

Sine, Triangle and Square - create repeating waveforms, with the wavelength (i.e. how often 
the cycle repeats) is set by the Snap value.  This can be extremely useful for creating repeti-
tive data.  CTRL, SHIFT and ALT act as modifiers to change the creation mode.

The Line tool allows the creation of notes in the editor, the editing of velocities and controller data 
in the controller lane (as seen on page 16), as well as automation data .  In the line and parabola 
mode it can be very useful for making smooth edits of velocity and controller data.  If you are feeling 
avant-garde, it can also be useful for creating unusual patterns of notes in the key editor.
In the key editor, another mode - Paint - exists, allowing free creation of note data.
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Editi ng Drums
While it is possible to edit drum parts that have been played using the key editor, it is oft en bett er to 
do this editi ng in the drum editor – this is for two main reasons.  Firstly, the length of a drum note is 
irrelevant – the sound will play for the same durati on regardless of how long you hold the key down.  
Secondly, with a drum part it is oft en important to be able to edit the velocity and quanti zati on of 
each drum instrument individually, and this is not easily achieved in the Key editor.  To open the drum 
editor, select a drum part and pick MIDI > Open Drum Editor.  You will see a window like the one 
below.
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There are many similariti es to the Key editor, but the main diff erences are listed below.
Each note (a drum sound) is represented by a single line, and named for convenience.  It is possible 
to alter the order of the notes by clicking and dragging them by their names) to their new positi on.
The controller lane will only show the velocity of the currently-selected notes – noti ce in the above 
diagram only the bass drum velociti es are shown.
Quanti ze can be applied globally or set individually; with Use Snap from Drum Map selected (as seen 
with the -|+ butt on below) then each drum instrument can be quanti zed to the appropriate value 
quickly and easily. It’s also possible to pick Use Quantize from here, and set a single value across all 
drum instruments.

By default, note durati on is not shown – each note is simply shown as a diamond, but the butt on be-
low right can show note lengths if this is required.    

The length of any notes created with the drumsti ck (the pencil tool, essenti ally) can be set with this 
menu - linked to the drum map or explicitly set. 
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Volume and  Panning
The last thing we’ll cover here is setti  ng volumes of parts – this is important as the balance between 
instruments is totally under your control – you can do this by setti  ng the volume using the slider in 
the inspector, as seen below.

The volume fader – from off  (left ) to loud (right) – click and drag the slider 
at the bott om to set it.
The pan control – this allows the sound source to be placed from left , 
through centre, to right; again click and drag the slider to set the positi on.

Both these controls work per track - it’s important to remember that the Inspector works on tracks, 
not on parts.

Incorrect - a part on the Melody track is selected, but the inspector shows 
the setti  ngs for the track which is selected, in this case the Drums.  Chang-
ing setti  ngs will alter the Drum track, not the Melody one.

Correct - the Melody track has been selected, so the inspector is now show-
ing the setti  ngs for that track.

Getti  ng the balance right between instruments can make a big diff erence to your compositi on and 
how it is perceived by the listener, so take some ti me to get this right.  Also note that if they are set to 
“off ” then it means that no value has been sent yet; it’s never a good idea to leave them like this as 
you may inherit odd setti  ngs from a previous sequence.

 The  MixConsole
You can also set the volume and panning using Cubase’s mixer, known as the MixConsole.  It can be 
summoned using the F3 key or via Studio > MixConsole.  You should see a window similar to the one 
shown below.  
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At the bott om right are the mixer channels.  These have faders which 
allow you to control the level of each channel.  The channels are colour 
coded - by default, red for input or output channels, and cream for in-
strument channels.  Moving the fader up or down will alter the volume 
of that track. The input seen on the left -most channel is the audio input 
- we will not be using this yet, but you may see a signal there (as seen in 
the screenshot) - don’t worry about it for the moment. The right-most 
channel is the Stereo Out, and it controls the overall volume of your 
project.

It is the same control as seen on the secti on on the Transport Bar earlier in this chapter. On the left , 
there is a secti on covering Visibility, History and Snapshots.  This will be covered in the mixer 
chapter, but you can make a channel disappear from the mixer by clicking the circle to the left  of its 
name.  The secti on at the top right is where more in-depth manipulati on of each channel can be per-
formed, adding in a variety of eff ects and processing.  We will not be using this secti on yet, but it will 
be covered later on in the mixer chapter and others.  Remember - the mixer’s appearance will change 
as you add more tracks, but the basics will remain the same.  The MixConsole is covered in detail in 
its own chapter on page 8.
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Instrument Tracks vs Rack Instruments
Cubase has two kinds of tracks with very similar features and functi on - Instrument Tracks and Rack 
Instruments.  Originally, there were only Rack Instruments, but as Cubase has developed, Instrument 
Tracks came into being, combining MIDI data and a VST into one enti ty.  When they were fi rst intro-
duced they had some limitati ons which have now largely gone, and as a result the two track types are 
now broadly similar.  Let’s examine both and look at what can be done with them.
  Instrument Tracks
These are the type of track we have already used, and they allow us to create and edit MIDI informa-
ti on, but to have that informati on turned into sound using a VST Instrument (oft en called VSTi).  As 
with all soft ware synthesizers, they rely on using the computer’s processor to create the sound, which 
can limit the number of sounds you can make (depending on how powerful your computer is, and 
how complex the synthesizer is).  There are two big positi ves to using them – fi rstly you can create 
more than one copy of these to make more sounds – with a physical synthesizer that is not the case.  
Secondly, all of the informati on about and editi ng of the track occurs in one place, on the track itself 
- the diagram below shows how an instrument track works - it consists of a track with MIDI Data in 
it (which you will already have edited), but also contains a VST Instrument.  The track then sends its 
output to the mixer.
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Don’t worry if you fi nd this confusing, you will probably fi nd for most applicati ons that Instrument 
Tracks will do what you need.
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VST Instruments and Separate MIDI Tracks
This way of using VST Instruments involves more steps – fi rstly you create the VST Instrument, and 
secondly you create a MIDI track to send data to it.

Firstly, go to Studio > VST Instruments and the VST Instruments 
window will appear. It can be accessed using F11 as well as the 
menu, and you can run up to 64 VST Instruments, depending on 
the version of Cubase that you are running.  If you have Instrument 
tracks, the instruments will appear in the top of the window, but 
to create a Rack instrument, click on the right, where it says Rack...

...to see a menu of the available instruments – we will select the 
Prologue that is included with Cubase.  Your list may be diff erent to 
this, depending on the plug-ins that you have installed. 

You will be asked if you want to create a MIDI track for the prologue 
– you will usually want to, so click Create

Next, the Prologue will appear on screen. It can be played with the 
on-screen keyboard, but we will need to route MIDI to it to use it 
for any sequencing work or playing live with a keyboard.

Here we see the outputs in the Inspector – note that the Prologue 
has appeared in a new ‘group’ on the list (and is currently selected).
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…and the Prologue patches can be accessed here or in the Inspec-
tor, giving a large range of sounds.  This is the same patch selecti on 
method as seen on page 8.
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The diagram below shows the connecti on between MIDI tracks and a VST Instrument which is in the 
rack.  As can be seen, multi ple MIDI tracks can be sent to the same VST Instrument. 
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Advantages and Disadvantages
Clearly, using Instrument tracks is much quicker and simpler.  In additi on you will noti ce later on when 
you start using automati on that it is much easier to do this using Instrument tracks, because every-
thing is in one place; if you are automati ng a “rack” VST then you will need to go and fi nd the track for 
the VST Instrument you are using, and in a large project this can take ti me.  In the past, Instrument 
Tracks were limited - they only had a single stereo audio output, and could only accept MIDI from the 
instrument track itself.  Now this is no longer the case, your preference is the main deciding factor 
between using Instrument Tracks and Rack Instruments.  If you like having everything integrated into 
one track, then Instrument Tracks are the way to go.  However, if you want to work with purely MIDI 
tracks and then send them to a single instrument (aping the way MIDI studios worked with physical 
synthesizers), then Rack Instruments may be the way to go.  When working with many instruments 
at once, you may fi nd that you need to use each synthesizer to produce many ti mbres at once (Multi -
Timbral synths provide up to 16 diff erent sounds), and then it may be simpler to use Rack Instru-
ments.  But at the moment, if you’re unsure then sti ck to using Instrument Tracks unti l it becomes 
apparent that you need to do something else.
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Sending MIDI to an Instrument Track
There are two main reasons to use extra MIDI tracks with an Instrument.  Firstly, you may want to 
have multi ple parts played by a multi -ti mbral synthesizer.  Some synths (such as Halion Sonic SE) have 
the ability to play 16 diff erent sounds, and when using this facility it makes sense to have each part 
on a diff erent track. Secondly, it may be desirable to have the musical parts that are played by a synth 
split across multi ple tracks to allow constructi on of layered and complex parts easily.  Whatever the 
reason, doing it will involve a new type of track - the MIDI Track.
MIDI Tracks contain only MIDI data.  There is no synthesizer integrated into them, so their output 
needs to be sent to a synth to turn the MIDI data into audio.
Creati ng one is done in the same way as other tracks - either right-clicking in the track list area, or go-
ing to Project > Add Track > MIDI.
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Once created, there are two important setti  ngs to alter.  The fi rst is the output - this picks the desti na-
ti on instrument that the MIDI data will be sent to.  This is done in the inspector, as seen here.
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The other setti  ng may or may not be crucial, depending on the synth; the MIDI channel.  MIDI data 
streams can contain up to 16 channels, and the synth may be ‘listening’ on a specifi c channel, or it 
may listen to all of them (this is called OMNI mode).  Oft en if there is no sound generated, the MIDI 
channel is wrong; many synths default to channel 1, so set it by clicking on the number either on the 
channel (as shown here)...

... or in the inspector - both are the same setti  ng, so use whichever is most convenient.
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Using more than one output on a VST Instrument
While in many cases as single audio output for a VST Instrument (VSTi) will be appropriate, there are 
some occasions when more than one output is useful, for instance having a multi -ti mbral VSTi (such 
as Halion Sonic SE), and wanti ng to apply Eff ects or Automati on to one of the sounds without it alter-
ing any of the others.  In such a situati on, it is possible to use more than one audio output on a VSTi, 
and the next secti on shows how to do this.  If you are just starti ng out in sequencing this may not be 
needed at this point, but there will come a ti me when you’ll want to do this - so if you’re following the 
book from start to fi nish, you may want to remember this and return at a later date. There are three 
main steps to achieving this - two are mandatory, and the last makes working in the project window a 
lot easier when you have multi ple tracks using diff erent outputs on the same instrument.
Se�  ng up the outputs in the rack
The fi rst step is to acti vate the extra outputs needed in the VST Instruments rack - either in the Right 
Zone (CTRL + ALT + R), or in the VST Instruments Window (F11).  By default this area is smaller than 
needed to see the outputs menu directly ...

... so resize the window to show all the opti ons.

To turn an output on or off , summon the menu using the outputs butt on...

...and a menu will appear showing all the possible outputs from that instrument:
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Extra outputs can be turned on here, and you will see a change in the Instrument track in the project 
window when it changes from 1 output...

 ... to 2:

This can be repeated for as many outputs as needed.  Remember that each output will add a track to 
the project window and mixer, so you may want to only turn on outputs as they are needed.
Assigning an output from inside the instrument
The next step is to change the audio output that a part inside the instrument is using.  This is diff erent 
for each instrument.  Here is Halion Sonic SE, on the Mix page, and the outputs are currently all set to 
Main at the right hand side of the window.
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Selecti ng a new output is as simple as clicking on the current output - which is Main by default - and 
picking one from the list.

Selecti ng a diff erent output will now cause the audio for that channel to be output there, allowing 
processing for that track to be achieved separately. Note that it is possible to select an output inside 
a VST Instrument which has not been turned on in the rack, and this will lead to that channel being 
silent. Note that it is possible to select an output inside a VST Instrument which has not been turned 
on in the rack, and this will lead to that channel being silent.
Separate outputs are not only useful for multi -ti mbral synths - many percussion synths can benefi t 
from this (with the kit eff ecti vely being a ti mbre per MIDI note, you could consider it a massively mul-
ti -ti mbral synth).  The same process can be applied, for instance, to Groove Agent SE5, by selecti ng a 
diff erent output per drum pad.  The output is selected in the Main area of Groove Agent, as shown 
below, and the output selected from the same list of 16 possible outputs.
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Linking the Inspector to the Output Track
One of the biggest drawbacks of using separate VST Instruments and MIDI tracks is that there are two 
tracks for the overall part - one for the MIDI data, and another for the audio output of the instrument.  
This can make editing a little more complex, and using Automation also means splitting attention 
between two tracks (some parameters will be part of the MIDI track, others will be part of the instru-
ment).  To make this a little easier, Cubase can be told which VST Instrument output track is being 
used by the MIDI track, allowing the Channel Settings window for that track to be opened quickly to 
view audio settings.  By default, it will be set to the main output of the instrument in question, as seen 
in the Inspector below (note that you may need to scroll down the Inspector to see this, depending 
on the overall window size and open sections in the Inspector).

This can be changed to any active output of the instrument in question by selecting it from the menu 
that pops up.

Clicking the e in the inspector will now open up the appropriate audio channel, and this alone can 
make the separation of multiple audio outputs from the MIDI tracks that they are being driven by 
much simpler to understand.
Setting up multiple outputs properly can take a little time, but the increase in creative possibilities it 
opens up compared to using a single stereo output mean that it is worth spending the time on it.  The 
first time you do this it will probably seem complex, but after a few sessions using it you will wonder 
how people got by without access to individual outputs for each part of a 16-part multi-timbral synth!
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Considerations for VST Instruments
Bear in mind that each VSTi uses your computer’s processing power to create sound (some more than 
others), so you may find that you can only run a few on your system before it runs out of processing 
power.  There is a great advantage of software synths though – if you need another one (and have the 
processing power) then you can just create another one in the rack – no extra expense!
Another issue is called latency – you may find that when you press a key, there is a delay before sound 
is heard.  This is latency, which is the delay between the CPU processing some audio (in this case mak-
ing a sound) and it being output by the sound card.  If there is a significant delay, you may need to 
alter the latency, or you can record your parts using a “normal” MIDI synth, and then play them back 
using a VSTi – this is possible because Cubase can take the delay into account when playing back a 
part from a MIDI recording.
MIDI Devices
When looking at the output list in the Inspector, you may wonder why there are different groups of 
outputs – there is always Not Connected available at the top, but in addition there can be three other 
groups.
The bottom group is a list of ‘actual’ outputs – these will be physical MIDI ports which exist on your 
setup, and often the Microsoft software synth that is part of Windows.  These will allow you to play 
MIDI, but Cubase will not give you any listings of patches that are available with them.
Above this there can be two different groups, which may alter depending on how you have the system 
set up.
There can be a list of “MIDI Devices” – this is a way of telling Cubase about the synthesizers you have 
in your studio, and what MIDI connections they use.  For instance, if your system has two MIDI out-
puts with a JV1080 attached to output 1 and an Emu Proteus 2000 attached to output 2, you could 
use the MIDI Device Manager to set these up.  They would then appear in the output list.  Although 
the MIDI information will still pass to the same output (output 1 if you have selected the JV1080), 
Cubase will now give you a list of the patches that a JV1080 has available, making sound selection a 
much easier proposition.
There can also be a list of VST Instruments – if you have set any of these up (as shown previously in 
this chapter) then each VST Instrument will appear here.



38

Lockdown Learning - Cubase Elements

do
w

nl
oa

de
d 

fr
om

w
w

w
.m

us
ic

te
ch

tu
iti

on
.c

om

The Project Window in Detail
You have already been using the Project Window - it is where the majority of your recording and ar-
ranging work will take place.  There are a number of features that have not been covered, so we will 
now look in more detail at the secti ons of it. It consists of a number of diff erent areas, most of which 
can be hidden from view, allowing you to give maximum space for the task you are working on.  

We will look at the diff erent areas of the project window that are available, and how to alter the set-
up; the default view may be a litt le crowded on some screens, and you will soon get used to altering 
the setup quickly to suit whatever you are working on at any given ti me.  Good knowledge of what 
informati on is available where, and how to control this quickly and effi  ciently is important to ensure 
that you are concentrati ng on the task in hand (creati ng music) rather than searching for informati on.  
Many setti  ngs in Cubase are available in multi ple locati ons, so being aware of this is also an important 
part of learning how to work effi  ciently.

The Main Area

This is where your tracks are shown, and any parts (be they MIDI, Audio or any other type) will be dis-
played.  On the left  of this secti on is the track listi ng area, and on the right is the main area where your 
parts will be.  Time runs from left  to right, and here the ti me shown in bars.  This part of the window 
is always in view, and is where you will be doing a considerable amount of the work you do in Cubase.

The Le�  Zone
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The left  zone holds two main tools - the Inspector and the Visibility list.  It can be toggled on and off  
with the keyboard shortcut CTRL + ALT + L, or with the butt on at the top right of the tool bar (where 
the right and bott om zones can be toggled as well):
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 The Inspector
The Inspector allows a wide range of setti  ngs for the selected track to be altered.  The informati on 
that is available here will depend on the track type.  Here is the Inspector view for three example 
tracks - Audio, MIDI and Instrument - which are the most common track types you will be dealing 
with, but there are others with diff erent functi ons available here.  Many of the changes you will make 
that apply to a track can be made here, although there are some (such as audio eff ects) which can 
also be made in the mixer as well as the channel setti  ngs window.

Audio Instrument MIDI
The Inspector can work in either Track or Editor mode; if an editor is open in the lower zone, then 
the editor secti on will become available, and the Inspector’s mode will depend on which window has 
focus.
Visibility
The Visibility secti on allows tracks to be hidden.  Note that hiding a track does not stop it playing back.  
It is possible to sync the visibility setti  ngs between the Project Window and the Mix Console by select-
ing that opti on in the menu to the right of Visibility - without this acti vated, the two are independent.
 The Right Zone
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The right zone holds four secti ons - VST Instruments, Media Bay, Control Room and Meter.  As with 
the Left  Zone, it can be toggled on and off  with the butt on at the top right of the tool bar, or with the 
keyboard shortcut CTRL + ALT + R.
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VST Instruments

This section (visible by default) shows any VST Instruments that you 
are using - the software instruments that take your musical informa-
tion and convert them to audio.  The two types of VST Instruments 
are both present here - the top section shows Instrument track in-
struments, while the lower section shows any which are being used 
as separate VST Instruments and MIDI tracks (Rack Instruments) - 
these are both covered in the section starting on page 29.  Most 
of the controls available here are available in the Inspector, but some 
- such as activation of extra outputs - are not. Note that under each 
instrument there are a number of controls available, giving quick ac-
cess to the most-used settings, avoiding the need to open the instru-
ment editor.

MediaBay

MediaBay gives quick access to a great deal of musical resources in 
one place, combining search of samples, sounds, MIDI loops and 
other information into one search engine.  Once a search has been 
completed, the results can be dragged directly to tracks (or to create 
new tracks if the search result is an instrument/sound combination) 
to quickly create music from the available resources. Making use of 
MediaBay’s facilities can vastly speed your workflow, allowing quick, 
seamless access to the considerable amount of content that is in-
cluded with Cubase.

Control Room
The Control Room allows complex routing for audio for performers 
to be achieved from within Cubase.  It is outside the scope of this 
book.
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 Meter
The meter secti on allows monitoring of the output level of your pro-
ject in Cubase without having to open the Mix Console.  This can be 
parti cularly useful if you are working on a laptop or any other com-
puter with limited screen space.

There are a number of opti ons available here, and choice between a 
Master output meter or a loudness meter.  

The Lower Zone
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The Lower Zone has four modes - MixConsole, Editor, Sampler Control and Chord Pads.  The fi rst two 
off er a parti cular view of an editor/functi on which is available elsewhere, but Sampler Control and 
Chord Pads can only be seen here.  The lower zone allows a fuller range of functi ons (such as editi ng 
and mixing) to happen while keeping Cubase in a single-window environment, allowing work on lap-
tops to be achieved without a myriad of overlapping windows.  It, too, can be toggled on and off  with 
the butt on at the top right of the tool bar, or with the keyboard shortcut CTRL + ALT + E.
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MixConsole
The lower zone MixConsole view allows the viewing of some of the features of the full MixConsole 
(see page 8 for a full description of the MixConsole).  By default, it will show the faders for the 
channels in the project - usually inputs, the tracks in the project and the Stereo Out - and it gives quick 
access to levels, panning, mute, solo and automation controls. 

There are two other views - Inserts...

...and Sends.

Editor

The editor view provides a version of the Key Editor (covered on page 16), allowing quick access to 
MIDI information on MIDI and Instrument tracks.
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Sampler Control

This mode provides all the controls for Sampler Tracks, which can also pop out into a floating editor 
window.

Chord Pads

Chord Pads reside here, and this is the only location they can appear.
Transport
In addition to the Transport Zone (see page 5), there is a floating transport bar (F2) which can be 
placed anywhere. On larger screens it can be useful to place it near your work area, and on smaller 
screens you can use only minimal controls and hide the Transport Zone to save space.  The features it 
has are identical to the Transport Zone, and learning to configure it to suit your needs at any time is 
an important skill in smoothing your workflow in Cubase.  

The Status Line

The Status Line gives information about the current project and setup - by default whether audio in-
puts and outputs are connected, and information about project setup and recording time.
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Info Line

The Info Line provides information about the currently selected object (the actual information dis-
played will change depending on the type of object selected).  From here it is often possible to dou-
ble-click to alter a value (useful when you want to make a precise setting).  If multiple objects are 
selected, then the information will be in yellow, and it is possible to alter all the objects at once here 
(useful when you want to apply the same change to multiple objects).
Project Window Layouts
The default setting for the project window is to have all of the areas viewable, and depending on your 
screen resolution this may be an acceptable setting.  On smaller screens (such as laptops), it may be 
more suitable to have fewer zones viewable, and indeed the near-minimal setting of only the inspec-
tor, info line and main area viewable is a more minimal setup for workflow in many situations. The 
active zones can be set by clicking Setup Window Layout (the triangle to the left of the cog at the top 
right), and selecting them from the menu that appears:

Backing up your work
It’s a fact of life – computers crash.  Modern computers are massively complex systems, and a single 
fault can render a computer unusable.  A hardware fault in a hard drive can mean a total loss of data, 
and with it hundreds (or even thousands) of hours or work lost.  In addition if you are working on a 
shared computer there is a chance of accidental data loss, and if your computer is connected to the 
Internet there is always the chance of a virus or similar program wreaking havoc on your computer 
and possibly with your data.  Many school computers will be restored from an image in the case of 
problems, and that usually means all the data on the computer is erased.
How can data loss be avoided?  Simple – back your work up.  Whenever you have made a significant 
change to a piece, save it, and whenever your session ends, save the work on the computer you’re 
working on and on another storage medium.  If you don’t, you run the risk of losing everything – if it’s 
in two places it’s extremely unlikely that both will suffer a fault at the same time.
The biggest issue here is making sure that all the data for the song is saved.  If you merely do Save 
As... then you are only saving Cubase’s project file (.CPR) – if you have only MIDI information then 
this will be adequate, but if you have any audio in the project then you need to save the audio files 
as well.  
To do this go to File > Back up Project... You will see a new dialog box where you can pick the 
location of the new project; this needs to be in an empty folder.  
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Once you have done this a new dialogue box will appear  where you can name the project fi le, and 
also choose backup opti ons.  If you are aiming to make a complete backup, then leave the boxes 
ti cked as shown below – this will not alter the audio fi les in any way, but will use the most space.  
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The unti cked opti ons are only relevant to audio operati ons, and will decrease the amount of space 
needed for the backup, but will decrease the possibiliti es for further editi ng.  What they will not do is 
alter the sound of your project, however.  Once you hit OK Cubase will save the project fi le to the new 
folder, and also create new audio fi les for it, inside that new folder.  The enti re folder is self-contained 
and therefore can be taken to any other Cubase setup.
If you regularly back up your project and audio fi les, you will never have a signifi cant loss of work.  It is 
a good idea to alternate between two fl ash drives for backups – aft er all, they are physically small, and 
easily lost.  Bear in mind that “my data was lost” is not a viable excuse either when at school, college 
or when working professionally recording clients!

 Exercises
Here is a list of tasks that will help you get started with sequencing - each chapter will have some 
exercises if they are relevant.  Whenever you start out with a new topic, getti  ng started is far more 
important than the material you are working on - the skills and techniques are important; the music 
itself isn’t.  Don’t att empt to sequence anything complicated at fi rst; simple melodies such as nurs-
ery rhymes are a great starti ng place and will mean you spend more ti me sequencing than worrying 
about what to work on.
 Sequence a simple melody
Make sure you set Cubase to an appropriate tempo (turn the tempo track off  and set the tempo on 
the transport bar), and sequence the melody accurately.  Use a simple sound such as a piano for this 
part of the task.
Sequence chords
You may already have the keyboard skills to play the correct chords or even harmonise the melody at 
sight.  If not, make use of step input (on page 20) to input the chords.  If you can’t work out what 
chords to play, then try to fi nd out what they should be, or harmonise the melody.  
Sequence a bass part
Your fi rst bass part can just be the root notes of the chords you have played, but if you want to in-
crease the complexity, you can create a more interesti ng bass part by changing the rhythm, or creat-
ing a part which doesn’t just use the root note of the chords.
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Sequence drums
Adding drums can be a challenge for many beginning sequencing students - both because drummers 
are usually playing more than one part of the kit at a time and also knowing what to play.  You can 
get round the ‘two things at once’ issue by either using cycle recording (page 12), step input (page 
20) or using the editor to input your part (page 16).  If you don’t know what to play, this drum 
part may get you started, so try to input it and then come up with developments of your own.
Change sounds
This will be done by using the inspector for the tracks in question, or changing the VST instruments to 
give a greater change in sounds.
Apply volume and panning
By using the mixer - as seen on page 28 - you can apply volume and panning to your tracks.  Re-
member that you can make some drastic changes to the way your piece is perceived by altering just 
the pan and volume of your parts.

Summary
The sequencing techniques you have seen above are basic, but they are the foundation of all MIDI 
sequencing that you will do.  Understanding them and performing them quickly will enable you to 
capture musical ideas quickly, and being able to quantize quickly and effectively can mean creating 
accurately sequenced parts quickly.  The only way to gain these skills (as with many others) is to 
practice.  Do this by picking a simple song to sequence at first (such as a Folk, Traditional or Christ-
mas Carol tune), and then progress onto longer, more complex songs with more parts and increased 
complexity within them.  It is often a good idea to practice on some music which already exists rather 
than your own composition as then you will only need to practice one element (sequencing) rather 
than working on creative elements as well.


